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Installation

Mac OS X

The installer puts the different files in the following folders :
= RTAS : Library\Application Support\Digidesign\Plug-Ins
= AAX : Library\Application Support\Avid\Audio\Plug-Ins
= VST : Library\Audio\Plug-Ins\VST\GRM
= Audio Units : Library\Audio\Plug-Ins\Components
= Stand Alone : Applications\GRM
= Documentation : GRM Tools Documentation

It installs also the Interlok Drivers necessary for authorization of the software.

To launch the installer, double-click on the GRM_Tools_Spaces.mpkg icon and follow the
instructions. If you do not want to install all available architectures, select the desired
components in the Installation Type.

PC Windows

The installer puts the different files in the following folders :

= RTAS : Program Files\Common Files\Digidesign\DAE\Plug-Ins

= AAX: Program Files\Common Files\Avid\Audio\Plug-Ins

= VST : GRM folder in the default VST folder (usually : Program Files\Steinberg\Plug-
Ins\VST) or Program Files\GRMVstPlugins if the default folder is not defined.

= Stand Alone : Program Files\Ina-GRM\GRM Tools

= Documentation : My Documents\GRM Tools Documentation

It installs also the Interlok Drivers necessary for authorization of the software.

On 64 bits systems, 32 bits plugins and applications are installed in « Program Files (x86) » .

To launch the installer, double-click on the GRM Tools Spaces Installer.exe icon and follow
the instructions.
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Authorization

Buy GRM Tools Spaces

When you make your purchase, you will receive a serial number (also called Activation Code)
and a link to the iLok.com website enabling you to authorize the plug-in. Take great care of
the serial number, as it constitutes proof of your purchase. You will need it to authorize the
plug-in and to contact the technical support unit.

Authorize GRM Tools Spaces

Authorization is carried out through the iLok License Manager application. ILok License

Manager is an application for Mac and PC that allows you to more easily manage your licenses
and iLok dongles.

The iLok dongle is no longer required. GRM Tools licenses can be either moved on the
computer or on an iLok dongle.

+ Create an account on iLok.com

* Download and install the latest iLok License Manager

* Launch iLok License Manager and sign in with your iLok.com ID
* Select « Redeem Activation Code » in « Licenses » menu

*  Copy the activation code

* Drag the generated license on a location displayed on the left column (iLok dongle or
computer).

Documentation and videos showing details of dongle and license management are available
on the iLok.com website.
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Universal Controls

Every plug-in contains a variety of interactive controls to vary, display, store, recall, and
otherwise manipulate parameters. The controls are:

= Sliders

= Elastic String

= Numerical Value Fields
= Buttons

= Presets

= Tempo

= SuperSlider

= Agitation

= Save/Load

= Window resizing

Sliders
—

To change the value continuously, drag the handle to the left or right.
To jump to a new value, click along the path of the handle.

To reset the default value, click on the handle while pressing the [Alt] key.

Elastic String

To achieve smooth movement of Sliders, 2DControllers, or the SuperSlider, click on the object
and move the mouse while holding down the [Command] key on Mac or [Ctrl] key on PC.
Note: In general, the follow speed of the smoothing function depends upon the length of the
Elastic String.
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Numerical Value Fields

B.0 ms

Note that a slider is often associated with a Numerical Value Field that shows the parameter
value as a number or other alphanumeric character. You can change the value in a Numerical
Value Field directly.

To change the value in a Numerical Value Field, click within the field and drag vertically
upwards to increment a value or downwards to decrement a value. To modify the increment
of change, drag while pressing the [Command] key on Mac or [Ctrl] key on PC.

Double clicking in a Numerical Value Field opens an editor enabling the direct modification of
a parameter value. Clicking outside the field or the [Return] key ends value editing.

Caution: with some host applications, the [Return] key is interpreted as a host command and
does not therefore end the editing of the value. In this case, click outside the editable field
to end editing.

Buttons
[ Freeee |
| ResetPhases  Random Phases

Buttons are used to change a state or start a process.

To change the state of a Button, or to start a process, click on the Button.

Presets

H Ellllllll

Each plug-in has memorization capacities for all settings, and recall capacities for the
memorizations.
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Gradual transition from one preset to another is carried out by linear interpolation of
parameter memories. The memorization zone is at the right of each window. It includes
sixteen memorization boxes, an interpolation time control slider and a status field.

= To save your current configuration of parameter settings into any of the 16 Preset
locations, click on a location number while holding down the [Command] key on Mac
or [Ctrl] key on PC. Note that the Status Field, located under the Preset locations,
gives the indication of the last performed operation.

= To call up a configuration of parameter settings from any of the 16 Presets, click on
that Preset number. Note that the Status Field indicates ‘Load'.

= To reload the factory configuration of parameter values, click while pressing down the
[Alt] key. Note that the Status Field indicates 'Reset'.

= Note that the factory default settings for presets 15 and 16 are random values. Preset
15 applies a random variation of about 10% deviation from the current value as set by
the user. Preset 16 generates a completely random set of parameter values.

The timing of the change from current values to the recalled Preset values is determined in
one of two ways:

* It can be determined by the current position of the vertical Slider located to the
right of the Preset numbers. To change the time of interpolation between current
parameter values and Preset values, move the vertical Slider up or down to reflect
your preferred timing.

* It can be recalled as one of the parameters saved in the Preset. To recall the time of
interpolation from a Preset configuration along with other parameters, click on the
Interpolation Button M, which is just underneath the vertical Slider, to activate it
before you click on the Preset.

During interpolation, clicking on a slider or a value field, stops the interpolation of this
parameter. The other parameters continue to be interpolated. To completely stop the
interpolation, click the Status Field.

A preset content can be copied and pasted into another preset of the same kind. For
instance, an Spaces VST preset can be pasted into another Spaces VST or even into an Spaces
StandAlone.

Copy preset 13

Paste preset 4 i

Aright-click on a preset opens a pop-up menu allowing to copy the preset into the clipboard.
When a compatible preset is available, its number is shown and it can be pasted into the
chosen preset. This new preset is now loaded.
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Tempo
This feature is only available with certain applications such as Cubase, ProTools, etc..

Certain parameters, such as the time of interpolation between presets, can be synchronized
with variations of tempo in the sequencer. To initiate synchronization, hold down the [Shift]
key and click on the Numerical Value Field associated with the parameter you want to
synchronize. The display will indicate in bold characters the figures that represent the
possible tempos. The figures and the tempos they represent are:

T/64 64th-note triplets
1/64 64th-notes

T/32 32nd-note triplets
./64  dotted 64th-notes
1/32 32nd-notes

T/16 16th-note triplets
./32  dotted 32nd-notes
1/16  16th-notes

T/8 8th-note triplets
/16  dotted 16th-notes
1/8 8th-notes

T/4 quarter-note triplets
/8 dotted 8th-notes
1/4 quarter-notes

T/2 half-note triplets
J4 dotted quarter-notes
1/2 half-notes

T/1 whole-note triplets
J2 dotted half-notes
1/1 whole-notes

J1 dotted whole-notes
1 bar measure

Larger numbers are indicated in numbers of measures, as in 3 bar for three
measures.

The parameters of each plug-in that can be synchronized are itemized in the sections dealing
with the individual plug-ins.

SuperSlider

i 2 3 a s & ki &
1

The horizontal SuperSlider and its associated Numerical Value Fields, located at the bottom
of each window, provide a powerful control for interpolating between Presets. Use the
SuperSlider to interpolate between any sequence of Presets to find new configurations and
create new Presets.
= To select a Preset number in a Numerical Value Field, click in the field and drag
vertically upwards or downwards.
= To change continuously from one Preset to another, drag the handle of the SuperSlider
to the left or right.

= To disable a Numerical Value Field, click in the field and drag vertically downwards to
an 'Off' position.
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Agitation

This set of controllers enables the adding of random variations to the processing parameters.
The left hand rotating potentiometer gives the amplitude (from 0% to 100%) of the random
variation. The right hand rotating potentiometer gives the speed of the variations (from 0 to
60 s). The On/Off button under the two rotating potentiometers activates the variations.

Four agitation groups are available:

Agitation 1 Anitatian 1
Agitation 1
i W Agitation 2

Agitation 3
Agitation 4

it
tle

A left click on the coloured button g to the right of each alphanumeric value
validates agitation for each individual parameter. A right click on the button opens the
agitation group selection menu.

Agitation 1
B Agitation 2

v Agitation 3 [

B Agitation 4 "¢

When the button is bright, the parameter is subjected to the variation. When it is dark, the
variation has no effect.

Caution: In the default configuration, agitation is deactivated for all parameters.

Save/Load

As an alternative to the save/load action in the host application, each plug-in contains
Save/Load Buttons located in the bottom of the windows. These buttons allow you to save
configurations of your plug-ins in a folder that you choose. They also allow you to exchange
configurations of GRM Tools plug-ins in other environments in which GRM Tools is used.
= Save opens the file selector to save the complete configuration (current values of the
parameters and the 16 presets).
= Load opens the file selector to recall a complete configuration (current values of the
parameters and the 16 presets).
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Window resizing

The plug-in window can be resized by clicking and dragging using the small triangle in the
bottom right hand corner of the ina-grm logo.

Caution : Excessively large dimensions may slow down the display of data in the plug-in
interface.

Midi management

All the processing parameters can be controlled by MIDI messages.
Important note: Some applications (for example Logic) do not send MIDI messages directly to
the processings, but propose other solutions to bind the messages to the parameters.

MIDI messages

The MIDI messages recognized by the processings are the following channel messages:
— Control Change

— Note On
Pitch Wheel
Program Change

The discrete controls (buttons, menus, Preset) behave differently depending on the messages:

* Control Change : the message values (from 0 to 127) are mapped on the parameter
variation range. For example, for a button, the values 0 to 63 trigger the “released”
state, and the values 64 to 127 trigger the “pressed” state.

« Pitch Wheel : similar to the previous control, but with a 14 bit message value range,
that is from 0 to 16383.

* Program Change : The program numbers correspond to the state of the parameter.
For example, Program Change 1 and 2 correspond to the “released” and “pressed”
state of a button. Alternatively, Program Changes from 1 to 16 correspond to the 16
processing presets.

* Note On : A basic note is bound to the parameter.

o For parameters with two states (buttons, or two-choice menus) each sending of
the Note On message with the same basic note switches the state of the
parameter. The other Note On messages have no effect, and can therefore be
used to control other parameters.

o For parameters with more than 2 states (Preset, menus, etc.), the basic note
corresponds to the first state, and the following note to the second state, etc.
For example, if the LA 440 (midi 69) is bound to the Preset parameter, the LA will
load preset 1, LA# preset 2, Sl preset 3, etc. Note On messages outside the
parameter variation range (for example, notes below LA440 in the previous
example) are not taken into account.

The Note On messages can be processed in a special way by certain types of processing (for
example, for Evolution transposition parameters). Refer to the description of each type of
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processing for more information on these special cases.

Binding a Midi message to a parameter

Paramaﬁer :
Message

Click on the MIDI button located next to the ina-grm logo, and underneath the Save and Load
buttons. A panel opens to the left of the button. Manipulate the parameter you want to
control on the plug-in interface. Its name is displayed on the Parameter line. Then send the
corresponding Midi message, which is displayed on the Message line in the following format:

[channel number][controller name][optional parameter]
The binding between the Midi message and the parameter is carried out and memorized.

¢ Unbind : cancels the Midi binding of the parameter displayed

* Close : closes the panel

* Reset All : cancels the Midi binding of all parameters.

* View : opens the window shown below, which enables the viewing of all bindings,
their modification and the addition of new ones.

() MIDI Binding

Parameter Channel Controler Parameter

Preset 1 Keyboard 60
Superslider - - -
Interspeed - - -
M= - - -

L Gain 1/ c | : -
| No Controler
L High

Control Change
L Low 9 : -

Keyboard
Y leyboard &0

i tanddl Pitch Wheel _ )

Program Change
L Pass/R_, g ge | }
R Gain - - -
R High 1 Control Change 10

R Low 1 Control Change 11

L Center

R Center - - -
R BandWidth - - -
R Pass /Reject - - -
Link - - -

7
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Multichannel

Spaces proposes outputs on several channels in AAX, RTAS, VST and Audio Units.

The channel allocations follow the standard configurations of each system:

Configuration RTAS/AAX Audio Units VST

Quad LR Ls Rs LR Ls Rs LR Ls Rs

5.0 LCRLsRs LRLsRsC LRCLSRs

5.1 LCRLsRsLFE LRCLFELsRs LRCLFELsRs

7.1 (8.0) LLcCRcRLsRsLFE|LRCLFELsRsLcRc|LRCLsRsCsLcRc

Configurations 7.1 & 8.0 are non-standard. It is a regular octophonic configuration without a

central channel staging successive stereo couples.

RTAS/AAX (SDDS)

Audio Unit
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Stand Alone

The following descriptions only concern the stand-alone versions.

Jaft / right

back [ froni

following time

spread

i
o=

distance

global doppler

DE

|NE
I

source orientation

source size
source rolation

source aperiure

In this version, the processing window includes at the top a strip to control the reading and
writing of sound files.

To select the number of output channels open the Audio tab in Option->Audio & Midi Setting
menu :

. S\
/ Audio \Record \‘

“*

output: | Digidesign HW ( HD } Test

“*

input: | Built-in Line Input

@ Output 1
@ Qutput 2
@ Qutput 3
@ Output 4

active output channels:

@ Input 1

active input channels:
n @ Input 2

44100 Hz

“*»

sample rate:

audio buffer size:

active midi inputs:

512 samples (11.6 ms)

@ IAC Driver IAC Bus 1
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To select a sound input:

m Options
Open Sound File...

Open Recent File »
Clear Current File

Record Sound File...

External Input

Select External Input in the Files menu to process an external sound.

Drag an audio file from a file browser into the horizontal grey zone at the top of
the window

Select Open Sound File... or Open Recent Files in the Files menu.

The file is loaded with a selection equal to its total time. To modify the start of the
selection, click close to the start and slide the mouse. To modify the end, click close to the
end and slide the mouse. Click&Drag inside the selection lets you simultaneously control the
start and the end of the selection.

A single click moves the cursor under the mouse.

The I-”-—L:t buttons control the read cursor. The first button sends the cursor back to
the start of the selection, the second starts the reading, or pauses it, and the third one loops
reading on to the selection.

To record a sound file:
select New Output Sound File... in the Files menu.

The file will be created in the WAV format. We recommend adding the extension .wav to
avoid any confusion at a later stage.

When an output file is open, the appearance of the advance button bar changes:

« = 2 @ /Users/GRM/Desktop/totowav O: 0 0

A new button can be used to start and stop recording. The name and the path of the file are
indicated, and its time.

Option->Audio & Midi Setting allows to choose the file resolution (16, 24 bits integer or 32
bits floating point) and the record mode:
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/ Audio/ Record

~ Record Modes

# Overwrite the current file
) Append samples to the end of the current file
() Automatically rename the current file

~ Bits per Sample
v Integer 16 bits
) Integer 24 bits
i0) Floating point 32 bits

) Split files

Split File option allows to split the output file in multiple mono files.
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Spaces

Spaces enables the positioning and movement of a multichannel source (from 1 to 32
channels) in a multichannel space (from 2 to 32 channels).

i ™\

speakers layoul BT ELLETY
R = ET A Front Stareo

Jeft f right

back / front

following time

spread

i
=

&
=
z
-3
E
_-

distance

global doppler

B9
tjo)

|
-

source orienlation

source size

source rolation

source aperiure

How does it work?

The source moves inside the speaker space in two modes:

Position
places in static mode the source at coordinates specified by the left/right and
back/front potentiometers. The layout of the channels of the source or of the
speakers can be edited.

Trajectories

the source follows trajectories that can be interpolated and drawn. The layout of
the channels is fixed and can only be modified in the Position mode.

The controls are explained below, in the paragraph entitled Reference (page 18).
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Getting started

It is assumed that the user is already familiar with the manipulation of the host applications,
the import and recording of a sound on a mono, stereo or multichannel track, access to the
various windows and the insertion of plugins. The following examples have been carried out
using the Stand Alone version of Spaces (see the Stand Alone chapter, page 13, to find out
more about this version). These examples can be transposed with no difficulty to the other
versions (VST, AAX, RTAS and Audio Unit). It is assumed that the user is equipped with an
audio interface with at least 5 outputs.

Launch Spaces StandAlone. Open Audio & Midi settings in the Options menu. Select 5
outputs in the active output channels list. Close the Options panel. The application
is now configured for an output on 5 channels.

GRM Spaces : 2 Piste audio.aiff (44.1 kHz)

|

4 » 3
gain 0 dB |'|=c:5mcr\' _

spoakers layout  [EREETTLTEY
ER Y T Front Stareo

(=]
=%
w

left f right

bacx | front

following time

!

spread

distance itati

|
0) -

global doppler

°B

source orienlation

source size

source rotation

source aperiure

Click on the Position tab. Check that speakers layout does in fact indicate 5
Channels. Open this menu: only compatible layouts with at least 5 channels can be
selected (Stereo and Quadraphonic).

Load a stereo sound and click the Start button. Click in the main window and move
the mouse. Observe the variations of the blue haloes around the speakers. They
represent the volumes applied at each output. These volume variations can be refined
by using the spread and distance parameters. Adjust source rotation to about 0.5.
The two channels rotate around the centre of the source in 2 seconds.

Click on the Trajectories tab. The centre of the source is moved along a circle and
the two channels continue their rotation.
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Click on the Square menu and select Star. Modify interpolation and observe the

modification of the trajectory.

Click briefly inside the main window. The source is positioned on the point closest to

the trajectory.

Click inside the main window and move the mouse to draw a new trajectory. This
User trajectory takes the place of Star. Adjust interpolation and observe the

modifications in the trajectory.

Reference

The Spaces interface has three zones:
1.

gain

o =
o [ posion |NEGHESTSIEN]

spoakers layout  [EReELLTTEY
LG E N Front Stareo

heft f right

back / frant

following tima

spread

distance

global doppler

source orientation

source size

source rotation

source aperiure

kL

a zone that is common to all the GRM Tools described in the Common controls

chapter.

a zone that depends on the control mode, that is Position or Trajectories.

a zone with more general adjustments (gain, Doppler, etc.) that are common to the

two control modes.
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Position

This control mode is obtained by Clicking on the Position tab.

T R
vosition | [INEGEEEIEN

speakers layout

sources layout
haft I right

bacx ! frant

following time

speakers layout

Menu enabling the choice of a layout amongst the 32 available, and its allocation
to the layout of the speakers. Only layouts with a number of channels that is
lower than the number of output channels actually available can be selected.
The configurations can be edited by using the Edit Layouts button.

sources layout

Menu enabling the choice of a layout amongst the 32 available, and its allocation
to the layout of the channels of the source. Only layouts with a number of
channels that is lower than the number of input channels actually available can
be selected. The configurations can be edited by using the Edit Layouts button.

left / right

Left/right coordinate of the position of the centre of the source. From -1 (left)
to 1 (right).

Back / front

Back/front coordinate of the position of the centre of the source. From -1 (back)
to 1 (front).

following time

Time taken by the source to reach the position defined by left/right and
back/front or by a click in the main window.

Edit Layouts
Button that opens up the layout editor.
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Layout editor

~ Layout

5 Channals
Channels - -

~ Speaker

(2] Right
g 045 RY 0.76

Weight

The left hand column lists the 32 possible layouts.

» Clicking on a name displays the layout in the central window, and its
name and characteristics in the Layout frame in the top right hand
corner.

* Click+drag is used to move an item in the list

+ Shift+Click+drag copies the start item into the end item.

The central window displays the selected layout. The orange zone represents the
influence zone of the selected output channel. A source located in this zone will
be transmitted in the corresponding channel with an amplitude that is
proportional to the intensity of the color. This zone has no significance when the
layout is used for a source. The spread potentiometer controls the spread of the
influence. At 0, there is very little overlap between the channels, at 1 the
influence is almost constant throughout the space, and the overlap is maximum.
The channels can be freely moved in the space displayed. When resizing the
window, press the [Shift] key to maintain the proportions of the central window.

The Layout frame on the right is used to:
» edit the name of the layout

* change the number of channels. The direct edition of the numerical field
initialises the position of the speakers in the default layout. Pressing the
+ or - button either adds a speaker in the centre or deletes the speaker
without modifying the position of the other speakers.

» apply the default layout, depending on the number of channels
+ import and export layouts in XML files. The file format is as follows:
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The name attribute indicates the name of the layout as it will appear in the list,
and the attributes x and y are the coordinates of the speakers between 1 and 1.
The number of channels is equal to the number of S items.

The Speaker frame on the right is used to:
» select a speaker by its number
» edit its name (Right in the example shown)
* modify its position
- using Cartesian coordinates (X and Y) by default

- using polar coordinates (Angle and Radius) if Grid polar is selected.
(0° at top, 90° on right, 180° at bottom and 270° on left)

* modify its influence using the Weight parameter (in dB)

Grid

Speaker

(2] Right
Y 0 J4 o

Weight

Rectangular
v Polar
[

displays a magnetic grid which can be rectangulz;r or polar.

Reset all Layouts

Resets the layout list:

1. Mono

Frontal stereo
Quadriphony
5 channels
Symmetrical octophony
Centered octophony

7. Stereo
The following layouts (empty) are reset in frontal stereo

oA wWN
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Main window

In this example, we have a source with 5 channels and an output device with 8
channels. The centre of the source is symbolized by a small blue disc, and the
channels of the source by numbered circles. The blue haloes around the speakers
indicate the amplitude of each output channel.

* Hovering (without clicking) over a speaker displays its influence zone and
its number, name, output channel, coordinates (X and Y from -1 to 1) and

its weight in dB.
5: Center
Out: 5
x:0u00
y: 0L.BB
w i 0.00

* Aclick moves the source.
* Aright click causes the appearance of a context menu:

v Display Gains
Display Levels
Display Infos

Rectangulat Grid
Polar Grid

Open Layout Editor

Display Gains. The blue haloes represent the amplitude of each speaker.

Display Levels. The blue haloes represent the actual level of the signals sent
to each speaker, just as a VU meter would do.

Display Infos. Displays the numbers, names, output channels and amplitudes
or dB levels of each speaker
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Rectangular Grid. Displays a rectangular grid as the window background.
Polar Grid. Displays a polar grid as the window background.
Open Layout Editor. Opens the layout editor (see page 20)

When resizing the window, press the [Shift] key to maintain the proportions of the
main window.

Trajectories

This control mode is obtained by Clicking on the Trajectories tab.

-
J-' Irajectories

interpolation
spaad

position

The two upper menus correspond to two trajectories, A and B, chosen from the
32 available. In the screen copy above: A:Circle and B:Star.

interpolation

controls interpolation between the two trajectories. Completely on the left the
effective trajectory is trajectory A, completely on the right is trajectory B. For
the intermediate values, the effective trajectory (red) is the result of
interpolation between trajectory A (green) and trajectory B (blue). In the
following example, the interpolation is 66% Star and 33% Circle:

Trajectories A and B are resampled on 1024 points to enable point-to-point
interpolation. The first point of trajectory A will be interpolated with the first

point of trajectory B. More generally, the nth point of A will be interpolated with
the nth point of B.

GRM Tools Space - 23 / 43



speed

position

time taken by the source to travel the trajectory. The shortest times are at the
limits of the travel of the potentiometer: to the left 0.2 s in the opposite
direction to the trajectory definition, to the right 0.2 s in the direction of the
trajectory definition. In the centre, the source stops, and the travel time is
infinite.

position of the source along the trajectory. When the speed is not zero, this
value is automatically updated.

absolute / relative

monitoring of the curvature of the trajectory by the source. When the button is
pushed in (relative), the source maintains the same orientation relative to the
trajectory. For example, if the trajectory is a circle, the various channels of the
source will maintain the same position relative to the circle, and will therefore
turn during their travel.

If the button is released (absolute), the position of the channels of the source
remains the same relative to the work space.

Caution: This position can also be modified by source orientation and source
rotation.

With relative:
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start
restarts the trajectory travel in the trajectory and segments mode.

dyn
opens the Dynamics window enabling the adding of a trajectory travel dynamic
variation (accelerations, slow-motion, etc.)
Circle
Elastic
These variations are not active in segment mode (see loop parameter)
loop

defines the trajectory travel modes.
loop : the trajectory is travelled in a loop

bounce : the trajectory is travelled alternately in one direction and then the
other

trajectory : the travel stops at the end of the trajectory. To begin travel again,
the Start button must be pressed.

segment : the travel stops at the end of each trajectory segment. The Start
button must be pressed to start a segment travel. This mode only applies to
multi-segment trajectories.

Edit Trajectories
Button opening the trajectory editor, initialized with trajectory A.
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Trajectories editor

Trajectory Editor

e ~ Trajectory ——

Spiral

Contal P e

Empty
Empty | EEsE— |
Empty ' '
Empty
Empty

Circle
i Square
| sar S

Empty
Empty
Empty
Empty
Empty
Empty
Empty

The left hand column lists the 32 possible trajectories.

» Clicking on a name displays the trajectory in the central window and its
name in the Trajectory frame in the top right hand corner.

* Click+drag is used to move an item in the list
» Shift+Click+drag copies the start item into the end item.

The central window displays the selected trajectory. The first points of the
trajectory are colored in orange.

A click in this window enables the modification of the trajectory:

Trajectory Editor

- Trajectory ——,
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* Click in the frame: translation of trajectory

» click outside frame: rotation of trajectory

» click in angles: proportional setting to scale

» click on sides: non-proportional setting to scale
» double click: validation of modifications

» [esc]: cancellation of modifications

The Trajectory frame on the right enables:
* the editing of the trajectory name
* initializing the selected trajectory using predetermined trajectories

(Circle, square, star, spiral, point) or by the interpolated trajectory of
the main window

Circle
Square
Star

Spiral
Central point

Current interpolated

* importing and exporting trajectories into XML files. The file format is as
follows:

The name attribute indicates the trajectory name as it will appear in the list;
the attributes x and y are the coordinates of the points between -1 and 1. The
optional attribute end indicates the end of a segment. The number of points is
equal to the number of P items and must be between 2 and 1024. Once loaded,
the trajectory is always resampled at 1024 points. The order of the points
determines the “normal” direction in which the trajectory is travelled, i.e. that
obtained with a positive speed value.

The exported trajectories always have 1024 points.

When resizing the window, press the [Shift] key to maintain the proportions of the
central window.
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Main windows

When the interpolation potentiometer is manipulated, 3 trajectories are
displayed:

trajectory Ain green
trajectory B in grey-blue
effective interpolated trajectory in red

After a few seconds trajectories A and B fade and disappear.

Click in the window places the source on the closest point in the
trajectory.

Click+Drag in the window is used to draw new trajectories. Edition mode
is stopped automatically after a few seconds of inactivity. The trajectory
drawn is resampled on 1024 points, and then stored in first position in
the list of trajectories and is allocated to trajectory B.

If the [Command] key on the Mac or the [Ctrl] key on the PC is pressed,
when the mouse is released, the drawing switches to point-to-point
mode. A new point will be inserted each time the mouse is clicked.
Pressing the [Shift] key forces the new point to vertical, horizontal or 45
diagonal. To exit point-to-point mode, release the [Command] key on the
Mac or the [Ctrl] key on the PC before releasing the mouse.

A right click displays the following context menu:
+ Display Gains
Display Levels
Display Infos

o

Rectangulat Grid
Polar Grid

Open Trajectory Editor

Display Gains. The blue haloes represent the amplitude of each speaker.

Display Levels. The blue haloes represent the real level of the signals sent to
each speaker, in the same way as a VUmeter.

Display Infos. Displays the numbers, names, output channels and amplitudes
or dB levels of each speaker.
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Rectangular Grid. Displays a rectangular grid in the window background.
Polar Grid. Displays a polar grid in the window background.
Open Trajectory Editor. Opens the trajectory editor (see page 26)

When resizing the window, press the [Shift] key to maintain the proportions of the
main window.

Global parameters

gain

mix

spread

distance

doppler

This parameter controls the level of the output signal from -96 to +12 dB.

This parameter controls the mix between the original sound and the processed
sound. At 100% only the processed sound is heard, and at 0% only the original
sound is heard.

controls the spread of the influence of the output channels. At O there is very
little overlap between channels, at 1 the influence is almost constant over the
whole space and overlap is maximum.

controls the variation in amplitude as a function of distance from the centre. At
0, amplitude does not depend on distance, and at 100% attenuation is maximum
when moving away from the centre, while at -100 % attenuation is maximum at
the centre.

controls the Doppler effect . At 0, no variation during movements, at 1,
maximum frequency variation. A click on the word “doppler” opens a menu for
definition of the effect application mode:

I distance

v global doppler
independant doppler
—

1 doppler
I

global doppler : The Doppler effect is applied globally to all channels of the
source. The centre of the source is taken as the reference for the movement,
and the same frequency variation is applied to all the channels.

independant doppler : The Doppler effect is applied independently to each
channel of the source. A different frequency variation is applied to each channel
as a function of its own movement.

source orientation

source size

orientation in degrees of the channels of the source relative to the layout
selected in sources layout.

size of the configuration. At 0, all the channels are at the centre of the source;
at 1, they are distributed over the whole space.
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source rotation

Applies a circular movement to the source around its centre from -10 Hz (anti-
clockwise rotation) to 10 Hz (clockwise rotation). This parameter takes priority
over source orientation.

source aperture

Controls the angle of opening of the distribution of the channels of the source:
30 % 100 % 150 %

1512
3 4
L]

At 100%, the channels are placed as defined in the layout editor.

I1/0 configuration

In most cases, the distribution of the input-output channels is carried out
automatically (see the multi-channel chapter, page 12). To modify this
distribution, click on the I/0 configuration button:

F

1/O Configuration

Inpust Dulput
12 | B E: Tl RS
- m [ [|] 5
“m ) momEw
mECEE
[ suround | [
_..-....!..... = i i

In this example, Spaces is configured with a stereo input and a 5 channels
output. The sequencer track channels (n-> or ->n) correspond to the matrix lines.
The input and output channels of Spaces correspond to the matrix columns. To
direct an output channel of Spaces towards an output track channel (or an input
track channel towards an input channel of Spaces), click in the corresponding
box of the matrix.
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In this example, speaker 2 of Spaces is routed towards channel 3 of the output
track. To help identify the channels, the surround menus placed under the two
matrices propose the most standard configurations:

Standard: 123456
40:LRCS
Quadra: LR Ls Rs
5.0Music: LRCLsRs
S.0Film : LCRLsRs
S0AU :LRLsRsC

Only configurations compatible with the number of channels can be selected.
The track channel numbers are then replaced by their standardized names (L, R,
Ls, etc.) and the configuration of the matrix is performed automatically. Caution:

the names of the channels and of the configuration are not memorized. This is
only a matrix definition aid.

It is thus possible to manage up to 32 inputs and 32 outputs:

Input

Output
102 83 4 5 6 7 B 9 1011 1213 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 28 30 M 2

1 2 3 4 5 6 7 8 0 1011 1213 141516 17 18 19 20 21 22 23 24 25 26 27 28 20 30 31 32

=1

=2

=3
] =4
]
=5

=7

=8
=3
=10
=1
=12

E =13
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SpaceGrain

SpaceGrain enables the generation of up to 100 grains and their placing in a multi-channel
sound space.

gain

100 %
spread ELTN randorm gain

)

i
P
#

Front Starec

5 Channels

g =

g
IIIIEI-g I

g =

number of grains duration

EEZE

random duration

anvelope

T [ 00 % | Mo | 100% | |
bacx 7 ront ml randaom gela I
Y
e | oo [ e ETE
- postan pitch
ETHI | oo 1

density random pitch

How does it work ?

Variable duration, delay, amplitude and transposition grains are sampled in the incoming
signal and distributed in a multi-channel space (up to 32 channels, depending on the
environment). Each grains performs a mono read. The input channels (up to 8) are randomly
allocated to the grains.

The controls are explained below in the paragraph entitled Reference (page 34).
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Getting started

It is assumed that the user is familiar with the manipulation of the host applications, the
importing and recording of a sound on a mono or stereo track, access to the various windows
and the insertion of the plugins. The following examples have been carried out using the
Stand Alone version of SpaceGrain (see the Stand Alone chapter, page 13, to find out more
about this version). These examples are transposed without difficulty to the other versions
(VST, AAX, RTAS and Audio Unit). It is assumed that the user has an audio interface with at
least 5 outputs.

Start SpaceGrain StandAlone. Open Audio & Midi settings in the Options menu.

Select 5 outputs in the active output channels list. Close the Options panel.

The application has now been configured for an output on 5 channels.

er of grains

EEZER
Teft right ola: ECTH0

bacs { rant

envelope

ranaom posibon

Check that the menu above Edit Layout does indeed indicate 5 Channels. Open this
menu: only compatible layouts with fewer than 5 channels can be selected (Stereo
and Quadraphonic).

Load a stereo sound file and start the reading. Observe the orange discs appearing in
the main window. They symbolize the grains. Your can modify their quantity with
number of grains, their duration with duration and their spatial distribution with
random position.

Set number of grains to 10, duration to 2 and random position to 30%. Click in the

window and move the mouse. The grains will follow the mouse with a delay that
depends on their duration.
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Reference

Spatial window

This window displays a multi-channel space symbolized by N speakers that correspond to N
output channels. The grains are displayed as orange circles whose intensities depend on the
envelope and amplitude of each grain.

clic + move
moves the center of the grains distribution in the multi-channel space
right clic

displays a context menu
v Display Gains
Display Levels
Display Infos

Rectangulat Grid
Polar Grid

Open Layout Editor

Display Gains. The blue haloes represent the amplitude of each speaker.

Display Levels. The blue haloes represent the actual level of the signals sent
to each speaker, just as with a VUmeter.

Display Infos. Displays the numbers, names, output channels and amplitudes
of dB levels of each speaker.

Rectangular Grid. Displays a rectangular grid as the window background.
Polar Grid. Displays a polar grid as the window background.
Open Layout Editor. Opens the layout editor (see page 20)

mix
This parameter controls the mix between the original sound and the processed

sound. At 100% only the processed sound is heard, and at 0% only the original
sound is heard.

spread

controls the spread of the influence of the output channels. At 0, there is very
little overlap between the channels, and at 1 the influence is almost constant
over the whole space and the overlap is maximum.
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gain
This parameter controls the level of the output signal from -96 to +24 dB.

random gain

Applies a random variation on the amplitude of each grain. At 0%, no attenuation
is applied, and at 100% attenuation varies randomly between 0 dB and -40 dB.

number of grains

The number of grains varies from 1 to 50. Depending on the envelope parameter,
grains may overlap more or less. In the event of overlapping, the quantity of
effective grains at a given moment can reach 100. Each grains performs a mono
read. The input channels are randomly allocated to the grains.

envelope

Amplitude envelope of each grain. At 0% the envelope is rectangular, and the
transition from one grain to the next is sudden. At 100%, the envelope is
triangular, and the grains are superimposed for half of their duration.

left / right

Left/right coordinate of the position of the centre of the source. From -1 (left)
to 1 (right).

Back / front

Back/front coordinate of the position of the centre of the source. From -1 (back)
to 1 (front).

random position

Random variation of the position of the grains. At 0%, all the grains are
positioned at the last known position of the mouse. At 100%, the grains are
distributed over the whole work space.

density
Density of grains that are in fact active. At 0% no grain is active, and 100% all
grains are active. The inactive grains are represented by grey points in the main
window.

duration

Duration of grains from 1 ms to 10 s. This duration may be automatically
modified as a function of the pitch parameters to avoid certain reading
incoherencies.

random duration

Random variation of duration of grains. At 0% duration is determined by the
duration parameter. At 100%, duration varies randomly between 1 ms and the
duration determined by the duration parameter.

delay

Delay of each grain relative to direct sound. The delay varies between 0 and 10
s. The delay may be automatically modified as a function of the pitch parameters
to avoid certain reading incoherencies.
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random delay
Random variation of delay. At 0% the duration is that determined by the delay
parameter. At 100% the duration varies randomly between 0 s and that
determined by the delay parameter.

continuous/chromatic pitch
Transposition of + or - one octave. The transposition is performed by reading at
variable speed. Depending on the duration of the grains, the acceleration, or the
slowdown, of the content of the grains will be perceptible or not. A click on the
label opens a menu for selection of continuous or chromatic transposition.

I v continuous pitch
chromatic pitch F
ich

random continuous/chromatic pitch

Random transposition of + or - one octave. The random variation is added to the
previous pitch parameter. A click on the label opens a menu for selection of

input
Stereo

aufput

|5 Channels |
| Editlayout
/0 Contiguratiar
| Holdoff

input
Menu enabling the selection of the input layout. Only layouts with a number of
channels lower than or equal to the number of channels of the track on which
the processing is inserted can be selected. Only the number of channels is taken
into account, and not the detailed layout of the channels. Stereo and Front
Stereo are therefore equivalent.
With 1/0 Configuration, this menu enables the selection of the input channels
that are actually used by the grains.

output

Menu enabling the selection of the output layout. Only layouts with a humber of
channels lower than or equal to the number of channels of the track on which
the processing is inserted can be selected.

Edit Layout

Button that opens the layout editor. See the description of this editor above, on
page 20.
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1/0 Configuration

Button that opens the input/output editor. See the description of this editor on
page 30.

hold

Button enabling the suspension of the writing of the incoming signal (Hold on).
The grains are then sampled in the last 10 seconds recorded.
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SpaceFilter

SpaceFilter is used to spatialize the signal by independent frequency bands.
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How does it work ?

The input signal spectrum is split into 4 independent bands to which are applied a delay and a
feedback. The output of each filter is positioned in a multi-channel space (up to 32 channels).

The controls are explained below in the paragraph entitled Reference (page 39).
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Getting started

It is assumed that the user is familiar with the manipulation of the host applications, the
importing and recording of a sound on a mono or stereo track, access to the various windows
and the insertion of plugins. The following examples have been carried out using the
StandAlone version of SpaceFilter (see the Stand Alone chapter, page 13, to find out more
about this version). These examples are transposed without difficulty to the other versions
(VST, AAX, RTAS and Audio Unit). It is assumed that the user has an audio interface with at
least 5 outputs.

Start SpaceFilter StandAlone. Open Audio & Midi settings in the Options menu. Select

5 outputs from the active output channels list. Close the Options panel. The

application is now configured for an output on 5 channels.

Check that the menu above Edit Layout does indeed indicate 5 Channels. Open this
menu: only compatible layouts with at least 5 channels can be selected (Stereo and
Quadraphonic).

Load a stereo sound file and start the reading. Observe the spectrum of the signal
displayed in the spectral window at the top of the interface. Click on the buttons 1:
On, 3: On and 4: On to the right of this zone. They switch all 3 to Off and only the
second band remains active.

Manipulate the center, width and delay potentiometers.

In the space window, only source 2 representing the second frequency band is
colored. You can move it directly with the mouse, or using the angle, radius and
rotation potentiometers that define its position in relation to the centre of the
screen. You can also move each channel around the position previously defined using
st size and st rot.

You can now activate the other bands and manipulate their parameters.
The choice of the band to be controlled is carried out by clicking directly on the band

in the spectral window, or by clicking on the corresponding source in the space
window, or by using the menu above the band validation buttons.

Reference

Spectral window

1y

gt

e

This window displays the logarithmic spectrum of the input signal and the four frequency
bands (red, blue, green and orange). The bands can be activated and deactivated using the 4
buttons on the right. When a band is deactivated, it is displayed in grey in the spectral
window.

clic + move
selects the band under the mouse, and moves it while keeping its width fixed.
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Cmd + clic + move (Mac)
Ctrl + clic + move (PC)

Alt + clic

as above, with modification of the band width by vertical movement.

reinitialization with four contiguous bands of the same width.

Band Parameters

The following parameters are applied to the selected band (by a click in the spectral window,
or by the menu in the top right hand corner).

center

width

ampl

delay

feedback

angle

radius

rotation

st size

central frequency in Hz

band width as %. At 100% the band covers the whole spectrum, if center is at the
centre.

amplitude of the filtered signal. From -96 to +24 dB

delay applied at the output of the filter. From 0 to 10 seconds.

percentage of feedback of the delay output towards its input.

angle in degrees of the source in relation to the centre of the spatial window. 0°
is at the top of the window, and 90°to the right. If rotation is not zero, this
parameter varies as a function of the current angle.

distance of the source in relation to the centre of the spatial window. At 100%
the source is on a circle (or an ellipse) that is tangent to the four sides of the
window.

speed of rotation of the source in relation to the centre of the spatial window.
From 0 to 10 seconds. The positive values correspond to rotation in the clockwise
direction, and the negative values to rotation in a trigonometric direction.

distance of the satellites in relation to the source disc. For a source at the centre
of the spatial window, 100% corresponds to a circle (or an ellipse) that is tangent
to the four sides of the window.
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st rot

rotation speed of satellites in relation to centre of spatial window. From 0 to 10
seconds. The positive values correspond to rotation in the clockwise direction,
and the negative values to rotation in a trigonometric direction.

These two parameters (st size and st rot) are only active if the processing input is stereo.

Spatial window

This window displays a multi-channel space symbolized by N speakers that correspond to N
output channels. The 4 frequency bands are placed in this space and are represented by four
colored discs numbered from 1 to 4 with the same colors as the corresponding bands in the
spectral window. If the processing input is stereo, two small satellites of the same color
symbolize the two channels. If a band is deactivated, the disc and any satellites are grey.

clic + move on a disc
selects the band corresponding to the disc and moves it in the multi-channel
space
right clic
displays a context menu
" Display Gains

Display Levels
Display Infos

Rectangulat Grid
Palar Grid

Open Layout Editor

Display Gains. The blue haloes represent the amplitude of each speaker.

Display Levels. The blue haloes represent the actual level of the signals sent
to each speaker, just as with a VUmeter.

Display Infos. Displays the numbers, names, output channels and amplitudes
of dB levels of each speaker.

Rectangular Grid. Displays a rectangular grid as the window background.
Polar Grid. Displays a polar grid as the window background.
Open Layout Editor. Opens the layout editor (see page 20)
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Global Parameters

mix

gain

spread

output

Edit Layout

This parameter controls the mix between the original sound and the processed
sound. At 100% only the processed sound is heard, and at 0% only the original
sound is heard.

This parameter controls the output signal level from -96 to +24 dB.

controls the spread of the influence of the output channels. At 0, there is very
little overlap between the channels, and at 1 the influence is almost constant
over the whole space and the overlap is maximum.

autput

Menu enabling the choice of one configuration out of the 32 available, and its
allocation to the speakers. Only layouts with a number of channels that is lower
than the number of output channels actually available can be selected. The
layouts can be edited by means of the Edit Layouts button.

Button opening the layout editor. See the description of this editor above (page
20).

1/0 Configuration

Button opening the input/output controller. See the description of this controller
on page 30.
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